
WxWidgets es un framework escrito
en C++ par a la creaci—n de apli-
caciones multiplataforma que

proporciona componentes para la creaci—n
de interfaces gr‡ficas de usuario (GUI) y
para otras muchas aplicaciones, como mani-
pulaci—n de gr‡ficos, lectura de ficheros ZIP,
comunicaci—n TCP/IP, etc. A diferencia de
otros frameworks multiplataforma, como
QT de Trolltech, wxWidgets utiliza los com-
ponentes nativos de la plataforma para la
GUI. Por ejemplo, en Linux se apoya en
GTK+, mientr as que en Windows utiliza la
API Win32. Esto se traduce en que la aplica-
ci—n adopta la apariencia nativa de la plata-
forma sin necesidad de emular el tema de
escritorio. Otro aspecto interesante es su
licencia, la cual permite crear aplicaciones
tanto libres como cerradas de forma gratuita.

wxFormBuilder es una herramienta de
c—digo abierto (licencia GPL) para realizar el
dise–o de la GUI de forma visual utilizando
wxWidgets. A pesar de que existen otras
aplicaciones similares (tanto libres como de
pago), wxFormBuilder incorpora caracter’s-
ticas muy interesantes para los desarrollado-
res avanzados, como por ejemplo la posibili-
dad de integrar componentes propios a tra-
vŽs de plugins. Usando esta herramienta se
reduce dr‡sticamente el tiempo de
desarrollo, ya que adem‡s de ahorrarnos
escribir todo el c—digo para crear la interfaz

gr‡fica, nos evita tener que compilar la apli-
caci—n para comprobar que presenta el
aspecto deseado.

Posicionamient o de Widget s
con Siz ers
La mayor’a de entornos RAD (Rapid Appli-
cation Development) permiten establecer la
posici—n y el tama–o de los controles gr‡fi-
cos (tambiŽn llamados widgets) de forma
manual, como si estuviŽramos dibujando la
ventana. Este sistema, aunque es sencillo e
intuitiv o para el usuario no iniciado, tiene
graves inconvenientes debido a que la posi-
ci—n y el tama–o de cada widget tiene un
valor fijo. Esto puede hacer que nuestra
interfaz gr‡fica se muestre incorrectamente
si modificamos el tipo de letra o el tema de
escritorio, como se aprecia en la Figura 1. La
edici—n manual requiere tambiŽn un mayor
cuidado a la hora de posicionar y dimensio-
nar los controles para mantener una interfaz
homogŽnea (misma separaci—n entre wid-
gets, correcta alineaci—n, etc.).

Para garantizar la correcta presentaci—n de
la interfaz, independientemente del tipo de
letra utilizado o de la plataforma donde se
ejecute, wxWidgets proporciona un meca-
nismo para establecer la posici—n y el
tama–o de cada widget de forma autom‡tica
mediante el uso de sizers. Un sizer es un
objeto que contiene un conjunto de widgets,

calculando su posici—n y tama–o en funci—n
del tama–o m’nimo requerido para su
correcta presentaci—n y del tipo de algoritmo
de emplazamiento (Layout). Por ejemplo, la
clase wxBoxSizer dispone los diferentes wid-
gets en una columna o una fila segœn el
valor de la propiedad orient. TambiŽn exis-
ten una serie de atributos (accesibles desde
la barra de herramientas) que permiten con-
figurar detalles como la alineaci—n, tama–o
de los m‡rgenes, si el widget es expansible o
si su tama–o debe ser proporcional al de la
ventana que lo contiene.
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Figur a 1: Problema de visualiz ación pr ovo-

cado por utiliz ar v alor es fijo s para la posi-

ción y el t amaño de los contr oles gráfic os.
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generar c—digo en C++ o como
fichero de recursos wxWidgets
(XRC). La opci—n por defecto es
C++ (y a que no todos los
widgets est‡n soportados en el
formato XRC) y genera un œnico
m—dulo, creando una clase por
cada uno de los formularios
(Forms) incluidos en el proyecto.
Existen aplicaciones similares que
permiten intr oducir c—digo en los

ficheros generados. Esto lo consiguen
normalmente agregando comentarios
especiales que marcan las secciones donde
el usuario puede introducir c—digo sin riesgo
a que se elimine en sucesivas
regeneraciones sobre el mismo fichero.
wxFormBuilder no permite esta
caracter’stica, por lo que no se deben
modificar los ficheros generados, ya que si
volvemos a generar el c—digo se perder‡n los
cambios.
Entonces Àc—mo puedo a–adir funcionalidad
a mi interfaz gr‡fica si no puedo a–adir el
c—digo sobre la clase generada? La respuesta
es sencilla, creando una clase derivada en
un fichero independiente. Por ejemplo,

supongamos que dentro del proyecto
tenemos un di‡logo llamado GUI_MiDialogo
y que hemos generado el c—digo en los
ficheros gui.h y gui.cpp. Bastar’a con crear
una clase (MiDialogo), en otro fichero, que
derivase de Žsta para a–adir toda la
funcionalidad necesaria. wxFormBuilder
declara los controles como atributos
protegidos (protected) y los manejadores de
eventos como funciones virtuales. Por tanto,
desde la clase derivada podemos redefinir el
c—digo de dichos manejadores,
permitiŽndonos acceder a todos los objetos
creados en la clase base. Con esta soluci—n
nos queda un c—digo mucho m‡s sencillo,
ya que no incluye el c—digo destinado a crear
la GUI, a menudo muy extenso y carente de
funcionalidad.

Una Alt ernativ a a C++:
Format o XRC
Un fichero de recursos XRC no es m‡s que
un fichero XML que contiene el dise–o de
una interfaz gr‡fica siguiendo un formato
definido por wxWidgets, cuya especificaci—n
se puede encontrar en la nota tŽcnica 14
(docs/tech/tn0014.txt) dentro de la
documentaci—n de wxWidgets. Estos
ficheros pueden ser cargados por la
aplicaci—n en tiempo de ejecuci—n,
permitiendo modificar la interfaz gr‡fica sin
necesidad de recompilar.
wxFormBuilder es capaz de generar el
c—digo en formato XRC, sin embargo, al
tratarse de un formato definido por
wxWidgets s—lo se contemplan aquellos
widgets incluidos en la versi—n oficial. Desde
el menœ View -> XR C Window o pulsando
F5 podemos previsualizar el resultado que
obtendr’amos de la carga del fichero XRC
generado por wxFormBuilder para
comprobar que efectivamente no hemos
utilizado ningœn widget que se salga de la
especificaci—n XRC.

wxFormBuilder se basa exclusivamente
en el uso de sizers para determinar la posi-
ci—n y tama–o de cada widget. Al principio
puede resultar algo m‡s costoso habituarse a
este sistema, pero una vez familiarizado con
Žl, resulta mucho m‡s sencillo y pr‡ctico
que la edici—n manual, ahorrando mucho
tiempo y obteniendo resultados con un
aspecto muy profesional.

Utiliz ación del Código
Generado: La Her encia
Una vez hayamos finalizado el dise–o de la
interfaz gr‡fica debemos generar el c—digo
correspondiente para utilizarlo en nuestra
aplicaci—n. wxFormBuilder es capaz de
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Para instalar wxFormBuilder podemos optar por compilar el
c—digo fuente o bien utilizar una versi—n precompilada en el caso
de que nuestra distribuci—n sea Ubuntu.

Para compilar los fuentes, en primer lugar deberemos instalar
wxWidgets (wxGTK-2.8.4), bien desde los paquetes de nuestra dis-
tribuci—n (en cuyo caso deberemos instalar los paquetes de
desarrollo) o bien compilando directamente los fuentes. wxForm-
Builder utiliza una versi—n modificada de una utilidad llamada pre-
make para generar los scripts de compilaci—n, permitiendo elegir
entre diferentes formatos segœn las herramientas de desarrollo
que utilicemos (GNU Make, Code::Blocks, etc.).

Desde el directorio donde hayamos extra’do los fuentes ejecutare-
mos el script create_build_files.sh , el cual generar‡ los Makefiles

necesarios para compilar wxFormBuilder mediante el comando
make. En el directorio output se encontrar‡n todos los ficheros
necesarios por la aplicaci—n, adem‡s del programa ejecutable,
situado en el directorio output/bin .

Si somos usuarios de Ubuntu, podemos ahorrarnos tener que
compilar wxFormBuilder , ya que se proporcionan paquetes pre-
compilados, tanto en formato tarball co mprimido (que incluye
wxWidgets precompilado) o bien en un paquete ÔdebÕ. En el primer
caso bastar‡ con extraer el contenido del paquete, mientras que en
segundo tendremos que instalar previamente la versi—n precompi-
lada de wxGTK-2.4.8 que se encu entra en el repositorio http://apt.
tt-solutions.com/ubuntu/ . En [3] encontraremos informaci—n deta-
llada sobre la instalaci—n de wxFormBuilder .

Instalaci—n de wxFormBuilder

01 #ifndef __mainframe__

02 #define __mainframe__

03 /**

04 @file

05 Subclass of GUI_MainFrame,

which i s generated by

wxFor mBuilder .

06 @todo Add your event handlers

dir ectly t o this file.

07 */

08 #include Žgui.hŽ

09

10 / * * Implementing GUI_MainFrame

*/

11 class MainFrame : public

GUI_MainFrame

12 {

13 public:

14 /** Constr uctor * /

15 MainFrame( wxWindow* par ent

);

16 void OnCalculateClick(

wxCommandEvent& event ) ;

17 void OnExitClick(

wxCommandEvent& event ) ;

18 };

19 #endif / / __mainframe__

Listado 1: mainframe.h

Figur a 2: Int erf az gráfica de la aplicación de ejemplo

(Calculador a MD5).
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Un Ejemplo Práctic o:
Calculador a MD5
Ahora que ya conocemos los conceptos
b‡sicos sobre wxWidgets y wxFormBuilder,
quŽ mejor que un ejemplo pr‡ctico para
aprender a utilizar esta herramienta. En Žl
crearemos una aplicaci—n para generar el
c—digo MD5 de un fichero utilizando
internamente el comando md5sum.

En primer lugar, realizaremos el dise–o de
la interfaz gr‡fica con wxFormBuilder, el
cual consistir‡ en una ventana que nos per-
mita seleccionar un fichero y mostrar el
c—digo MD5 calculado (Figura 2).

En la Figura 4 se muestra la pantalla que
aparece tras iniciar wxFormBuilder, donde
se distinguen cuatro elementos principales:
¥ çrbol de objetos, donde aparecer‡n todos

los componentes creados en nuestro pro-
yecto.

¥ Paleta de componentes, los cuales est‡n
agrupados en pesta–as para localizarlos
f‡cilmente.

¥ Editor, donde se mostrar‡ el aspecto de
nuestro dise–o (pesta–a Designer). Tam-
biŽn podemos visualizar el c—digo que
generar’a wxFormBuilder seleccionando
las pesta–as C++ y XRC, aunque no se
permite su edici—n.

¥ Propiedades del objeto seleccionado,
desde donde podremos modificar las pro-
piedades del objeto y crear manejadores
de eventos asociados a Žste.

Lo primero que debemos hacer es configurar
las propiedades del proyecto y grabarlo en
un fichero, ya que el c—digo se genera en
una ruta relativa a Žste. Para modificar las
propiedades del proyecto seleccionaremos el
objeto ra’z (de tipo Project) en el ‡rbol de
objetos, y a continuaci—n editaremos las pro-
piedades name para dar un nombre a nues-
tro proyecto y file para indicar el nombre de
los ficheros a generar, por ejemplo gui, gene-
rando as’ los ficheros gui.h y gui.c.

A continuaci—n creamos la ventana princi-
pal haciendo click en el componente Frame
situado en la pesta–a Forms de la paleta de
componentes. Editamos la propiedad name,
la cual se corresponder‡ con el nombre de la
clase en el c—digo generado, y title para esta-
blecer el t’tulo a la ventana.

Ahora tenemos que crear el contenido de
la ventana usando sizers para emplazar los
objetos tal y como se coment— anterior-
mente. ƒstos s—lo se pueden crear por
debajo de componentes que puedan conte-
ner a otros (por ejemplo, una ventana o un
panel) o bien por debajo de otro sizer. Por

tanto, no podremos crear un sizer debajo de,
por ejemplo, un bot—n o un control de texto.
Para crearlo, basta con seleccionar el objeto
sobre el que queremos crear el sizer y hacer
click en el sizer correspondiente, que en Žste
ser‡ de tipo wxBoxSizer. wxFormBuilder
siempre trata de crear los objetos por debajo
del objeto seleccionado, pero si por alguna
raz—n Žste no puede crearse en ese lugar, lo
intentar‡ crear un nivel m‡s arriba en el
‡rbol hasta llegar a la ra’z que se corres-
ponde con el objeto proyecto. De esta forma,
si intentamos crear un objeto de la pesta–a
Forms, Žste ser‡ creado en el primer nivel del
‡rbol, independientemente del objeto que
estŽ seleccionado.

Adem‡s de crear objetos, a menudo ten-
dremos que cambiarlos de lugar, bien cam-
biando el orden dentro de un sizer o colo-

carlo en otro sizer diferente. Esto se puede
llevar a cabo de varias maneras, bien arras-
trando con el rat—n o haciendo click con el
bot—n derecho desde el ‡rbol de objetos, o
bien desde las opciones del menœ de edi-
ci—n, donde se proporcionan atajos de
teclado para realizar estas acciones con
mayor agilidad, ya que se realizan con
mucha frecuencia.

Ahora que sabemos c—mo crear objetos,
cambiarlos de sitio y editar sus propiedades,
continuaremos con el ejercicio pr‡ctico tra-
tando de crear una estructura de objetos
como la mostrada en la Figura 3, sin prestar
mucha atenci—n, de momento, a las propie-
dades de cada uno de ellos. Si todo lo hemos
hecho bien, obtendremos un dise–o funcio-
nall, pero no exactamente armonioso. Efecti-
vamente, el resultado no es lo que esper‡ba-
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Una caracter’stica que diferencia a
wxFormBuilder de otras herramientas
para dise–ar la GUI de wxWidgets es la
posibilidad de a–adir componentes no
incluidos en el conjunto est‡ndar de
wxWidgets de forma sencilla.

Todos los controles gr‡ficos que pode-
mos encontrar en la paleta de componen-
tes no est‡n implementados dentro de
wxFormBuilder , sino como plugins que
se cargan al inicio de la aplicaci—n. Un
plugin consta b‡sicamente de tres fiche-
ros: un fichero xml que describe los com-
ponentes incluidos y sus propiedades,

otro que incluye una serie de plantillas
para realizar la generaci—n de c—digo de
cada componente y un peque–o m—dulo
en C++ (que se compila como biblioteca
compartida) que incluye el c—digo para
crear la instancia del componente para
ser presentado en el editor .

En el c—digo fuente de wxFormBuilder
podemos encontrar el c—digo de los plu-
gins que incluyen de serie (en los subdi-
rectorios plugins y output/plugins ) a
modo de ejemplo, y en [3] un breve tuto-
rial para crear un plugin sencillo con un
solo componente.

A–ade tus propios widgets creando Plugins

01 #include Žmainframe.hŽ

02

03 MainFrame::MainFrame( wxWindow*

par ent )

04 :

05 GUI_MainFrame( par ent )

06 {

07

08 }

09

10 void

MainFrame::OnCalculateClick(

wxCommandEvent& event )

11 {

12 wxAr rayString output;

13

14 if

(m_fpFile ->GetPath().IsEmpty())

15 {

16 m_tcMD5->Clear();

17 r etur n;

18 }

19

20

21 wxString

command(wxString(wxT(•md5sum

Ž) ) + m_fpFile ->GetPath());

22

23 i f (wxExecute(command,output)

== 0 && output.Count() > 0)

24

m_tcMD5->SetV alue(output[0].Bef

or eFirst(wxChar(• •)));

25 else

26 m_tcMD5->Clear();

27 }

28

29 void MainFrame::OnExitClick(

wxCommandEvent& event )

30 {

31 Close();

32 }

Listado 2: mainframe.cpp
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proporcional al de la ventana que lo con-
tiene. Esto se consigue desde la barra de
herramientas (utilizando los iconos a la
izquierda de las opciones de los bordes) o
desde el panel de propiedades, con la desac-
tivaci—n de la opci—n wxEXPAND correspon-
diente a la propiedad flag y poniendo a 0 la
propiedad proportion.

3. Alineamos el sizer bSizer3a la dere-
cha seleccionando la opci—n correspon-
diente desde la barra de herramientas o
activando la opci—n wxALIGN_RIGHTde
la propiedad flag.

4. En el sizer fgSizer1, hacemos agran-
dable la segunda columna dando un valor
de 1 (se numeran desde 0) a la propiedad
growablecols

5. Activamos  la opci—n wxEXPAND de
los objetos m_tcMD5y m_fpFile.

Con estos sencillos pasos y modificando
el texto de las etiquetas de cada control ya
tendremos el dise–o que esper‡bamos a
falta de crear los manejadores de eventos
para procesar el click de cada bot—n. Para
realizarlo, basta con ir a la pesta–a Events
en las propiedades del objeto y asignar un
nombre al manejador del evento OnBut-
tonClick. Asignaremos los nombres
OnCalculateClick y OnExitClick para los

botones m_btCal-
culate y m_btExit
respectivamente.

Pues con esto
termina el dise–o
de la interfaz gr‡-
fica de usuario,
s—lo nos queda
generar el c—digo
(File -> Generate
Codeo F8) y crear
la clase derivada
para implementar
la funcionalidad de
nuestra aplicaci—n.

wxFormBuilder
es capaz de generar
el esqueleto de la

clase derivada haciendo click en el menœ
Tools -> Generate Inherited Classo pul-
sando F6. Debemos configurar el nombre
de la clase derivada y de los ficheros.

Sobre estos ficheros a–adiremos el
c—digo de los manejadores de eventos para
implementar la funcionalidad deseada. Los
listados 1 y 2 muestran el c—digo completo
de la clase derivada de nuestra aplicaci—n,
donde se puede apreciar la enorme claridad
que aporta la separaci—n del c—digo corres-
pondiente a la interfaz gr‡fica en un
m—dulo independiente. Para completar la
aplicaci—n es necesario crear el m—dulo
principal (Listado 3) que se encarga de
crear la ventana y mostrarla en pantalla. En
[5] podemos encontrar un v’deo tutorial
que muestra el proceso de creaci—n de este
ejemplo.

Conclusione s
Afortunadamente, cada vez es mayor el
nœmero de aplicaciones disponibles para
diferentes sistemas operativos. Esta es una
caracter’stica muy interesante tanto para
los desarrolladores de software, que ven
como pueden abarcar un conjunto mayor
de usuarios, como para los propios usua-
rios, los cuales no se ven obligados a utili-
zar un sistema u otro para ejecutar las apli-
caciones que les son de utilidad. wxWid-
gets nos brinda esta posibilidad a travŽs de
una API comœn que oculta todos los deta-
lles del sistema operativo y del toolkit gr‡-
fico.

La creaci—n de interfaces gr‡ficas de
usuario escribiendo el c—digo manual-
mente es una tarea que requiere mucho
esfuerzo, incrementando el tiempo de
desarrollo notablemente. Sin embargo, gra-
cias a wxFormBuilder esto deja de ser un
problema, convirtiendo el dise–o de inter-
faces gr‡ficas de usuario en un proceso
f‡cil y r‡pido. �

mos, pero veamos que modificando las pro-
piedades relacionadas con los sizers la cosa
cambia. Realicemos los siguientes pasos:

1. Eliminemos los bordes de m_pnBack.
Puede hacerse  desde la barra de herramien-
tas (iconos de la derecha) o desde el panel
de propiedades, desactivando wxALL de la
propiedad flag (dentro de la categor’a 

2. En el sizer bSizer3, modificamos la pro-
piedad orient a wxHORIZONTAL, y hacemos
que el sizer no sea expansible ni de tama–o
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[1] P‡gina principal de wxFormBuilder:
http://www .wxformbuilder .org

[2] Foro de discusi—n de wxFormBuilder:
http://forum.wxformbuilder .org

[3] Documentaci—n de wxFormBuilder:
http://wiki.wxformbuilder .org

[4] P‡gina principal de wxWidgets: http://
www .wxwidgets.org

[5] V’deo demostrativo de wxFormBuil-
der: http://wiki.wxformbuilder .org/
uploads/Main/wxfb_tutorial.avi

RECURSOSFigur a 4 : Pant alla princip al de wxFormB uilder.

Figur a 3: Árbol de obje t os de la Calculador a

MD5.

01 #include Žwx/wxpr ec.hŽ

02 #include Žmainframe.hŽ

03

04 class MyApp : public wxApp

05 {

06 public:

07 bool OnInit();

08 };

09

10 IMPLEMENT_APP( MyApp )

11

12 bool MyApp::OnInit()

13 {

14 MainFrame *frame = new

MainFrame(NULL);

15 frame ->Show();

16 r etur n t r ue;

17 }

Listado 3: main.cpp
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